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Note: Always maintain the RAZOR™ EX instrument in good working order. If the instrument is used in a manner not specified by Idaho Technology, then protection provided by the equipment may be impaired.
 The RAZOR™ instruments, reagents, manuals, and software are subject to International Traffic in Arms Regulations (ITAR), administered by the U.S. Department of State, Directorate of Defense Trade Controls (DDTC) and requires an export license, prior to shipping. The RAZOR instruments, reagents, manuals, and software may not be exported or transferred to any foreign nationals without prior approval by DDTC. For more information please visit: www.pmdtc.org
 RAZOR™ EX Basic Training Workbook RAZR-PRT-4024 Rev. 03 2/2011
 © Copyright 2007–2011, Idaho Technology Inc. All rights reserved. Printed in the United States of America.
 The information contained in this document is subject to change without notice. No part of this document may be reproduced or transmitted in any form or by any means, elec-tronic or mechanical, for any purpose, without the express written permission of Idaho Technology, Inc.
 RAZOR software, Detector, and Metacall software modules © 2002–2011 Idaho Technology, Inc.
 RAZOR is a trademark and RAZO R is a registered trademark of Idaho Technology, Inc. All other names of products and brands appearing in this manual are trademarks or registered trademarks of their respective owners.
 The purchase of this product includes a limited, nontransferable license under specific claims of one or more U.S. patents as listed on Idaho Technology, Inc.’s Web site (http://www.idahotech.com/LegalNotices/) and owned by the University of Utah Research Foundation and/or Idaho Technology, Inc. The following products are licensed under U.S. Patent Nos. 5,338,671 and 5,587,287: PATH-ASY-0006, PATH-ASY-0007, PATH-ASY-0008, PATH-ASY-0009, PATH-ASY-0010, PATH-ASY-0011, PATH-ASY-0056, PATH-ASY-0061, and PATH-ASY-0091. RNaseOUT™ Recombinant Ribonuclease Inhibitor is the subject of one or more issued and/or pending U.S. and/or foreign patents and patent applications owned by Invitrogen Corporation. Idaho Technology Inc. is licensed to sell the RNaseOUT™ Recombinant Ribonuclease Inhibitor contained in PATH-ASY-0056 for environmental testing purposes only subject to a certain license agreement executed between Life Technologies Corporation., and Idaho Technology, Inc. The sale by Idaho Technology Inc. of this product conveys to the recipient the non-transferable right to use the provided amount of the product for environmental testing conducted by the recipient. For information on purchasing a license to use RNaseOUT™ Recombinant Ribonuclease Inhibitor for purposes other than those permitted herein, contact Business Development and Licensing Department, Life Technologies Corporation, 5791 Van Allen Way, Carlsbad, California 92008. Phone (760) 603-7200. Email: [email protected]
 Printed in the United States of America.
 Idaho Technology makes no warranty of any kind with regard to this material, including, but not limited to the implied warranties of merchantability and fitness for a particular purpose. Idaho Technology shall not be liable for errors contained herein or for incidental consequential damages in connection with the furnishing, performance or use of this material.
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 CUSTOMER AND TECHNICAL SUPPORT
 Reach Us On the Web
 Idaho Technology’s Web site is - http://www.idahotech.com
 We strongly encourage users to visit our Web site for answers to frequently asked questions, updated information, and additional insights into operating the RAZOR EX instrument.
 Reach Us By E-mail
 Contact Idaho Technology by e-mail in the following areas: [email protected] - Technical Support [email protected] - General Support
 Reach Us By Phone
 Technical support is available during the following times: 8 a.m. to 5 p.m. - Mountain Standard Time
 For technical support call: 1-800-735-6544 - Toll Free (United States and Canada) (801) 736-6354 - Utah +1-801-736-6354 - International
 Reach Us By Fax
 To contact Idaho Technology by fax, use the following numbers: 1-801-588-0507 - United States and Canada +1-801-588-0507 - International
 International Returns
 Call Technical Support for instructions on returning instruments from outside of the United States.
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 - .....................................negative+ .....................................positiveA ....................................amp (ampere)µL ...................................microliter (10-6 Liters)C ....................................CelsiusCD-ROM ........................compact disk read-only memoryCl ...................................chlorinecm ..................................centimeterCp ..................................crossing pointDNA ...............................deoxyribonucleic aciddNTP..............................deoxynucleotide triphosphatedsDNA ...........................double-stranded DNAF ....................................FahrenheitFAM ...............................carboxyfluoresceinfg ...................................femptograms (10-15 g)FRET .............................fluorescence resonance energy transferITI ..................................Idaho Technology Inc.LED ................................light emitting diodeMg ..................................magnesiummin. ................................minutemL ..................................milliliter (10-3 L)mm .................................millimeter (10-3 m)ng ..................................nanograms (10-9 g)nm ..................................nanometer (10-9 m)OS .................................operating systemoz ...................................ouncePBS ...............................phosphate-buffered salinePC ..................................personal computerPCR ...............................polymerase chain reactionpg ..................................picogramsPPE ...............................personal protective equipmentPTFE .............................polytetrafluoroethylene (Teflon®)RNA ...............................ribonucleic acidRT-PCR .........................reverse transcription polymerase chain reactionsec. ................................secondSNP ...............................single nucleotide polymorphismTAMRA...........................carboxy tetramethylrhodamineTaq .................................enzyme from Thermus aquaticusTm .................................melting temperatureUSB ...............................universal serial busUV ..................................ultravioletV ....................................voltW ...................................watt
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 Introduction
 INTRODUCTION TO RAZOR™ EX BASIC TRAININGIdaho Technology’s (ITI) RAZOR EX instrument is a user-friendly real-time PCR system that requires no special lab equipment or skills. Some of its unique features that make it ideal for field use include the following:• The instrument can run repeatedly on a rechargeable battery pack or a DC power supply. • The instrument doesn’t require a computer for operation although data can be downloaded,
 stored, and printed on a computer using universal serial bus (USB) or Bluetooth®. • Samples are easily collected, prepared, and inserted into the machine using a needle-free
 syringe and a pouch with self-contained freeze-dried chemicals. • The pouch is scanned by bar code to program the machine and then placed in the instrument
 which displays positive calls in real time.
 This workbook details the curriculum and instructional material for the operator training. It is designed to provide reference and other supplemental material for the student.
 Student feedback in the form of notes and comments is greatly appreciated and will contribute to the overall learning experience of the class. This document forms the basis for modifying, improving, and enhancing future iterations of RAZOR EX training courses.
 We greatly appreciate your participation!
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 CHAPTER 1: PRINCIPLES OF PCR
 What is DNA?
 DNA (deoxyribose nucleic acid) is the genetic material of most organisms. It consists of the building blocks adenine, guanine, cytosine, and thymine (abbreviated A,G,C,T), also called nucleotides, or more specifically deoxynucleotide triphosphates (dNTPs).
 In nature, DNA is a double helix consisting of two strands of varying nucleotide combinations. The nucleotides on the one strand complement the nucleotides on the matching strand by pairing A to T and G to C. This pairing or bonding, causes the two strands to twist around each other like a spiral staircase.
 What is PCR?Polymerase chain reaction (PCR) is a technique used to amplify DNA. This technique provides the most specific and sensitive assays available. From a single DNA molecule and specific building blocks, subsequent DNA copies can be made. The RAZOR EX System offers the most advanced and easy-to-use real-time PCR detection system available today.
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 Chapter 1: Principles of PCR
 Theory
 A single strand of DNA cannot be analyzed easily, but billions of copies of DNA can.
 In nature cells copy their DNA using replication. When any cell divides, enzymes called polymerases make a copy of all the DNA in each chromosome. To do this the two DNA chains of the double helix are “unzipped”. As the two strands separate, DNA polymerase makes a copy using each strand as a template.
 This process can be duplicated in the lab by mixing the DNA with nucleotides and other chemicals and repeatedly heating and cooling the DNA strand. Starting with one copy of DNA, two copies are made after one cycle, four after two cycles, etc. After 30 cycles, PCR will produce over a billion DNA copies that can then be measured.
 ������������
 �������
 �� �����
 �������
 �� ����
 ������
 �� �����
 ������
 �� ������
 �������
 �� �����
 �������
 �� �����
 �������
 A modification called reverse transcriptase PCR (RT-PCR) is used for detecting organisms that have RNA as their genetic material (as opposed to DNA). RT allows RNA sequences to be amplified indi-rectly. The enzyme reverse transcriptase is used to copy the RNA into complementary DNA (cDNA); the cDNA is then amplified by PCR.
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 Applications of PCR
 PCR is valuable to researchers because it allows them to multiply unique regions of DNA so they can be detected in large genomes. Researchers in the Human Genome Project use PCR to look for markers in cloned DNA segments and to order DNA fragments into libraries.
 Biowarfare AgentsPCR is used to identify biological threat organisms.
 Clinical DiagnosticsPCR is used to detect diseases such as human immunodeficiency virus (HIV); human papillomavirus (HPV); herpes simplex virus (HSV); breast, ovarian, and colon cancers; and other devastating diseases.
 Drinking and recreational water is regularly monitored for quality and safety by using PCR.
 Criminal InvestigationIn forensic science PCR is useful due to its sensitivity. Even minute quantities of DNA left over from previous applications can be reamplified, leading to a conclusive result.
 Genetics StudiesPCR is so efficient at multiplying specific DNA sequences that DNA isolated from a single human cell can be screened for mutations associated with various genetic dis-orders.
 PCR can also be used to detect the presence of unwanted genetic material, as in the case of a bacterial or viral infection.
 BIOHAZARD
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 Chapter 1: Principles of PCR
 Master Mix
 To copy DNA, polymerase requires two other components: a supply of the four-nucleotide bases and a short sequence of nucleotides called primers. DNA polymerases, whether from humans, bacteria, or viruses, cannot copy a chain of DNA without using something to “prime” the process, or get it started. So the cell has another enzyme called a primase that actually makes the first few nucle-otides of the copy. This area of DNA is called a primer. Once the primer is made, the polymerase can take over making the rest of the new DNA chain.
 Master Mix is a complex mixture of primers, probes, dNTP molecules, polymerase enzyme, and buffer. Sample DNA is added to this mixture to perform PCR.
 Sample DNA• Provides the target template.
 Primers• Approximately 25 bases long (nucleotides adenine (A), thymine (T), cytosine (C), and guanine
 (G), which act as the building blocks and backbone of DNA)• Define each end of the sequence of DNA to be amplified• Complementary to a specific region of interest• Anneal to denatured (separated) DNA template• Docking station for polymerase• Excess amounts in master mix ensures the primer will bind to
 the complementary sequence of interest
 Probes • Approximately 25 bases long (nucleotides adenine (A), thymine (T), cytosine (C), and guanine
 (G), which act as the building blocks and backbone of DNA)• Specific to target DNA and have fluorescent dyes attached to
 their sequences.• Types of probes
 - Hybridization probes have one red probe and one green probe that are designed to hybridize together and then fluo-resce.
 - Hydrolysis probes have one green probe that is cut and then fluoresces.• Fluorescence is proximity dependent
 Did You Know...Driving up to Mendocino and thinking about an experiment to look at one particular letter of the genetic code, I designed a system in my mind. As I repaired the things I thought could go wrong with it, suddenly I generated something that if I did it over and over again would be PCR. It would go 2, 4, 8, 16, 32 . . . in 30 cycles make as many base pairs from one little region as I had in the whole genome! That was the eureka point. I said: “holy cow! By putting the triphosphates [DNA building blocks] in there myself, I could do this process over and over and amplify the DNA…”
 --Interview: Kary Mullis (April 1992)
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 • When bound, instrument LED excites the green dye, which then excites the red dye leading to measurable fluorescence
 dNTPs - Deoxynucleotide Triphosphates• Needed for DNA synthesis• dNTPs have a nucleotide and an energy donor• Nucleotide bases are the actual building blocks used to create
 the copied DNA strand. • Bind in pairs: A and T, C and G• Equal amounts of nucleotides are used to prevent mismatches of bases• Defines amplicon (targeted area of DNA)
 Enzyme • Polymerase enzyme builds the DNA copy by placing each nucleotide
 base in its proper position.• Stable at very high temperatures >100°C• Must have a template strand of DNA to copy
 Buffer• Maintains the optimal reaction pH (a measure of the strength of acids and
 bases) for PCR• Contains stabilizing ions• Polymerase requires free ions for activity
 Water• The universal solvent and standard diluent
 –
 How Does PCR Work?
 Each PCR cycle comprises three processes: denaturation (the separation of DNA strands), primer annealing, and primer extension. Denaturation is achieved by heating the DNA, while primer annealing and primer extension occur at lower temperatures. The PCR therefore involves tempera-ture cycling, and the DNA polymerase used in the reaction must be tolerant of high temperatures and rapid heating and cooling.
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 DNA at room temperature in a normal environment
 Step 1. Denaturation The first part of the process separates the two DNA chains in the double helix. This is done simply by heating the pouch to 90–95ºC (about 200ºF). The RAZOR EX System heats up to 91ºC to sepa-The RAZOR EX System heats up to 91ºC to sepa-rate the double-stranded DNA molecule.
 Step 2. Annealing and ExtensionThe primers cannot bind to the DNA strands at such a high temperature, so the pouch is cooled to 60ºC (about 140ºF). At this temperature, the primers bind or “anneal” to the ends of the DNA strands.
 The final step of the reaction is to make a complete copy of the templates.
 Did You Know...The three steps in the polymerase chain reaction take less than 2 min.
 • At the end of a single cycle, each piece of DNA in the pouch has been duplicated. • A typical PCR program will run a total of 30–60 cycles. • Each newly synthesized DNA piece acts as a new template, so with 30 cycles, 1 billion copies of a single
 piece of DNA can be produced in less than 30 min.
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 The enzyme begins adding nucleotides to the primer and eventually makes a complementary copy of the template. If the template contains an A nucleotide, the enzyme adds on a T nucleotide to the primer. If the template contains a G, it adds a C to the new chain, and so on to the end of the DNA strand. This completes one PCR cycle.
 The three steps in the polymerase chain reaction—the separation of the strands, annealing the primer to the template, and the synthesis of new strands—take less than 2 min. Each step is carried out in the same pouch. At the end of a cycle, each piece of DNA in the pouch has been duplicated. A typical PCR program will run a total of 30–60 cycles. In the RAZOR EX, annealing and extension are combined into one single step.
 Each newly synthesized DNA piece can act as a new template, so after 30 cycles, 1 billion copies of a single piece of DNA can be produced! Taking into account the time it takes to change the tempera-ture of the reaction pouch, 1 billion copies can be ready in about 30 min.
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 Two-Step Temperature Cycling
 Temperature Hold Time Acquisition Cycles
 Hold 93ºC 120 sec. N/A 1
 Denature 91ºC 3 sec.55
 Anneal 60ºC 15 sec. Single
 �����
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 PCR Analysis
 Agarose Gel
 Size Marker
 1000 bp750 bp500 bp400 bp300 bp
 Product
 Limitations of Agarose Gel • Poor precision• Low sensitivity• May require carcinogenic chemicals• Short dynamic range • Low resolution• Non-automated• Size-based discrimination only• Results not expressed in numbers• Post PCR Processing
 Did You Know...The fluorescence increases over time as more DNA is duplicated.
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 Real-time PCR
 Advantages of Real-time PCR
 • Increased dynamic range of detection • No post-PCR processing• Very sensitive• Fluorescence proportional to amount of initial target present in sample
 Probes
 Probes and Real-time Analysis
 In real-time PCR, a fluorescent dye or probe is used to measure product. These probes are also specific to the target DNA and the product is measured by the RAZOR EX fluorimeter.
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 Hybridization Probes
 Hybridization probes are composed of a pair of DNA strands, designed to hybridize adjacent to each other. Each carries a dye at its facing ends. These fluorophores interact. The shorter wave dye, green, excited by blue light from the instrument’s LED, transfers its energy to the longer wave dye, red. This fluorophore emits red light, which is detected by the instrument. Therefore, the signal will only activate when both probes bind adjacent to each other. The fluorescent signal will be propor-tional to the number of copies of the target sequence.
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 Hydrolysis Probes
 A hydrolysis probe (often sold under the tradename TaqMan®) provides a quantitative signal of amplified samples. The shortcoming of this technique is that the probe is destroyed during the PCR process.
 The probe consists of a DNA strand of approximately 20–30 bases with a quencher dye at one end and a reporter (fluorescent) dye at the other end. After the probe hybridizes with the target DNA strand, light from the instrument’s LED stimulates the reporter dye to emit a signal, which is absorbed by the quencher. When the enzyme hydrolyzes (decomposes with water) the probe, the quencher is separated from the reporter (along with the synthetic DNA bases), and the excited reporter fluoresces. A detectable signal occurs only when the probe is hydrolyzed by the enzyme. As DNA is amplified, this process repeats, increasing the fluorescent signal of the sample.
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 CHAPTER 2: THE RAZOR EX SYSTEM
 How the RAZOR EX Instrument WorksThe RAZOR EX Instrument operation is based on fluorimetric measurements and polymerase chain reaction (PCR). Polymerase chain reaction uses heating and cooling cycles to make copies of target deoxyribose nucleic acid (DNA) or ribose nucleic acid (RNA)—the genetic material of an organism.
 This instrument is designed to run 12 samples at one time in a flexible sample pouch. Each sample pouch contains proprietary freeze-dried reagents designed to detect specific biologic agents.
 These freeze-dried reagents contain everything needed to identify the specified target agent(s) in an unknown sample.
 After preparing the reagent pouch, the operator inserts the pouch into the instrument through the top slot. Samples are moved between heat zones to achieve temperature cycling. During temperature cycling, reagent pouches copy or amplify target DNA that is present. The sample pouch sits next to fluorimeter optics where real-time fluorescence readings are taken during the run. As more copies are made, the sample fluorescence increases. Over many cycles, the fluorescence increase has the shape of an exponential curve showing amplification of the target.
 The RAZOR EX software makes pathogen identification simple due to its ability to make positive calls as they occur during the run.
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 Inside the RAZOR EX Hard Case
 RAZOR EX Instrument Parts
 Below is a list of items that are included in the RAZOR EX instrument package.
 Item Part Number
 RAZOR EX Hybridization Probe System RAZR-ASY-4000RAZOR EX Hydrolysis Probe System RAZR-ASY-4001USB Cable RAZR-PRT-0080RAZOR EX Operator’s Manual RAZR-PRT-4018Quick Guides (in Manual) RAZR-PRT-4019, -4020Battery Recharger RAZR-SUB-420024 V 4 A Power Supply POWR-SUB-0022Instrument Battery Pack RAZR-SUB-0009Air Filter Assembly RAZR-SUB-0015Power cord 110V POWR-CRD-0001Power cord 220–230V POWR-CRD-0002RAZOR EX Desktop Software RAZR-SCD-4000Hard Carrying Case RAZR-CAS-0002Instrument grab strap RAZR-SUB-0029RAZOR EX Training CD RAZR-SCD-4001RAZOR EX Training Manual RAZR-PRT-4024Tool Kit
 5 1/2" Needle Nose Pliers 5234Lens Cleaning Solution 1803
 Lens Cleaning Tissue 1802
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 RAZOR EX Instrument Buttons
 Push Buttons
 LCD Screen
 Button name FunctionPower Turns power on (press for 5 sec.) Brightness Controls brightness of the LCD screen displayArrow Back Takes user back to the previous screenArrow Up Allows user to scroll up in a screenArrow Down Allows user to scroll down in a screenSelect Selects highlighted option on the screen
 Basic RAZOR EX Operational Requirements
 The RAZOR EX can do multiple runs and analyses as a hand portable instrument in the field. Before the RAZOR EX is run, the user must upload protocol files by scanning the appropriate bar codes. This can be done in advance or immediately before the run. Once protocols are uploaded, the RAZOR EX can run and store 75 runs before data management of the run data is necessary. After use, the RAZOR EX run data can be downloaded to a computer for storage, review, and printing.
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 RAZOR EX Operational Schematics
 LCD Screen
 Plunge Bracket
 Pouch Slot
 Power Key
 Backlight Control
 Back Key
 Up Key
 Select Key
 Battery Pack (inserted)
 Down Key
 Serial Label
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 USB Port
 Bar Code Reader
 Power Port
 Schematic of a Sample Pouch inserted into a RAZOR instrument
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 RAZOR EX Instrument Reagent Pouches
 A Sample 4 x 3 Pouch with Key Parts Labeled
 Plunger (load position)
 Plunger Comb
 Sample Inlet Ports
 Freeze-driedReagent
 Sample Slot
 Negative Controls
 Positive Controls
 Unknown Sample 2
 Unknown Sample 1
 RAZOR ® 11+1 10 Target Screen
 Anthrax
 Brucella spp.
 Botulism A
 Coxiella
 E. coli O157
 Tularemia
 Ricin
 Salmonella
 Smallpox
 Plague
 ICPC
 Inlet PortInlet Port
 A Sample 11 + 1 Pouch (The 10®)
 The RAZOR EX reagent pouches are made of thin, clear, flexible plastic attached to a semi-flexible loading body. The clear plastic provides a large surface area to allow for rapid heat exchange and efficient fluorescence monitoring. Preparation of the sample pouch does not require centrifugation or pipetting, making it ideal for field use. Liquid and powder samples are collected, prepared in liquid, and inserted into the pouches with syringes. When the syringe is inserted into
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 the inlet port, the correct amount of the liquid sample is drawn by vacuum into the sample pouch. The reagent pellet, freeze-dried inside each well, dissolves upon contact with the liquid sample. Each vacuum-sealed sample pouch contains freeze-dried reagents, pouch plungers and plunger comb, and comes with a sample kit for liquids or powder and a loading kit containing syringes and reagent grade water.
 Pouches have a shelf life of 6 months and come in test configurations of 4 x 3, 6 x 2, 11 + 1, 12 x 1, and 10 + 2.
 Preparation of the sample pouch does not require centrifugation or pipetting, making it ideal for field use. Liquid samples are collected and inserted into the pouches with syringes. When the syringe is inserted into the inlet port, the liquid sample is drawn by vacuum into the sample pouch. The reagent pellet, freeze-dried inside each well, dissolves upon contact with the liquid sample. Each kit contains the following:
 • Vacuum-sealed sample pouch with freeze-dried reagents, plungers, and plunger comb • Syringes• Transfer pipettes • Lysozyme• Buffers• Instruction booklet
 RAZOR Inhibition Controls
 The 10® and The 8™ pouches are set up to analyze the quality of the sample introduced to the pouch. These pouches have inhibition control reactions to measure the effect of inhibitors in a sample. Without these controls, samples with strong inhibitors have the potential to result in a false negative call. Inhibition is measured as a failure of these reactions to amplify.
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 CHAPTER 3: SAMPLE HANDLING AND REAGENT POUCH PREPARATION
 Sample Collection
 Sample Prep Reagent Prep Run Reaction
 Start Finish
 Biohazard Contamination PCR Contamination
 This workflow is designed to minimize both biological and PCR based contamination. Material and supplies in each of the four areas should not be transferred to other areas unless they have been decontaminated.
 Sample Handling
 Sample preparation should be done before reagent preparation. Each DNA sample must be in liquid form before running PCR and have a minimum vol-ume of 500 µL (0.5 mL). Sample preparation is essential because samples must be free of any contaminating salts or other compounds that would dis-rupt or inhibit the enzymatic reactions and fluorescent dyes required to run the reaction. Before beginning to sample, label all unknown tubes with unique identifiers (i.e., Sample 1).
 SNAP!
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 Dry Sample (Powders, etc.)1. Touch the dry swab to the unknown powder.2. Place the swab into the appropriately labeled vial and break off at break point.3. Secure the cap on the vial and shake vigorously for 30 sec.4. If dilution is NOT necessary, proceed to the “Loading Reagent Pouches” section in this
 booklet.5. Repeat for the remaining samples using a fresh swab and correctly labeled
 vial.
 Liquid Sample (Automatic air samplers, etc.)1. Transfer approximately 0.5 mL of liquid to the appropriately labeled vial.
 Note: To draw a sample with the transfer pipette, first squeeze and hold the top of the bulb. Insert the tip of the pipette into the liquid and release the bulb to draw sample up to fill line (see illustration). Transfer the pipette to the vial and squeeze the bulb to empty the sample into the vial.
 2. Secure the cap on the water vial and shake vigorously for 30 sec.3. Repeat for the remaining samples using a fresh pipette and appropriately labeled
 vial.4. Load the diluted samples into a pouch following the instructions found in the
 “Loading Reagent Pouches” section in this booklet.
 DilutionFor a sample that might contain a high level of inhibitors, a dilution step may be nec-essary. To perform a dilution on dry or liquid sample, follow these steps:
 1. Add sample to a vial as described in the previous two sections.2. Transfer approximately 0.5 mL from the vial to another labeled vial (i.e.,
 Diluted Sample 1) using a transfer pipette.3. Secure the cap and shake vigorously for ~30 sec.4. Load both the undiluted and diluted samples into a pouch using the “Reagent
 Pouch Loading” section.
 Once the raw sample has been prepared properly, load the sample into the pouch.
 For more instructions on preparing dry and liquid samples, please see either the specific pouch assay card protocol or the RAZOR Detection Kit booklet.
 Top of bulb
 Fill liquid to here(about .5 mL)
 Top of bulb
 Fill liquid to here(about .5 mL)
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 Reagent Pouch Preparation
 Consult the protocol card that accompanies each pouch for specific loading directions.
 WARNING: Pouch must be used within 30 min. of opening.
 1. Confirm that the foil bag is air tight. If the bag is not air tight, contact ITI Technical Support, because reagents may have been compromised.
 2. Remove the freeze-dried reagent pouch from the aluminum can and air-tight foil bag (use tear notch to break seal and access pouch).
 3. Place the pouch on a flat, clean surface with the inlet ports and label face up. Make sure plunger comb is in place.
 Kit Contents RAZOR EX pouch containing freeze-dried reagents in a foil bag
 Assay card to match reagents
 Sample swabs (pack) 1 and/or 3 mL syringes with tips
 5 mL unknown sample bottles 5 mL reagent grade water
 Instruction booklet 0.5 mL transfer pipettes (pack)
 2 mL transfer pipette
 How to Load a Syringe
 WARNING: Do not prepare syringes until indicated by the instrument pouch prompts.
 1. Uncap the end of a syringe. The end of the syringe is preloaded with a cannula tip necessary for RAZOR EX freeze-dried pouch loading. If you have syringes without the preloaded cannula tip, load the tip on the syringe using aseptic technique (avoid touching cannula tip to other sur-faces).
 2. Insert cannula end of syringe into reagent grade water or prepared sample.
 3. Draw reagent grade water or the sample into the syringe by pulling up on the syringe plunger until it reaches the appropriate mark (see the assay card for specific instructions):
 • 0.5 mL for a 4 x 3 format • 0.2 mL for a 12 x 1 format• 2.0 mL for an 11 + 1 format (The 10® pouch) • 0.35 mL for a 6 x 2 format
 Avoid introducing any air into the syringe, which can cause bubbles.
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 WARNING: If there are air bubbles in the syringe, DO NOT remove them by tapping and then pushing bubbles out of the tip into the air (this could contaminate both you and your area). Instead, reinsert the syringe into the sample vial and slowly express the liquid. Slowly redraw the sample into the syringe. Repeat until the liquid in the syringe is free of air bubbles.
 Reagent Pouch Loading for 4 x 3 Pouch
 With the unknown samples, use the following steps to insert them into the sample pouch and run a test.
 Follow the prescribed order below to minimize cross-contamination and user error:
 Step 1Water for Negative Controls
 Step 2Unknown Sample 1
 Step 3Unknown Sample 2
 Step 4Water for Positive Controls
 Black Labeled Tube
 Orange Labeled Tube
 Blue Labeled Tube
 Black Labeled Tube
 Negative Controls (Positions 1, 2, 3) - Black Labeled Tube (water for controls)
 1. Fill a syringe with 0.5 mL of water for controls.2. Gently insert the cannula tip into the negative inlet port. Push the syringe down until you feel
 an ease in resistance.
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 WARNING: DO NOT push the syringe plunger to force liquid into the pouch. This can fill the pouch with air and may damage the pouch or cause contamination.
 3. Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly. Once the syringe plunger has stopped moving, remove the syringe and discard it in a biowaste container.
 Unknown Sample 1 (Positions 4, 5, 6) - Orange Labeled Tube
 1. Fill a new syringe with 0.5 mL of Unknown Sample 1.2. Gently insert the cannula tip into the Unknown Sample 1 inlet port. Push the syringe down
 until you feel an ease in resistance.3. Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly.
 Once the syringe plunger has stopped moving, remove the syringe and discard it in a biohazard waste container.
 Unknown Sample 2 (Positions 7, 8, 9) - Blue Labeled Tube
 1. Fill a new syringe with 0.5 mL of Unknown Sample 2.2. Gently insert the cannula tip into the Unknown Sample 2 inlet port. Push the syringe down
 until you feel an ease in resistance.3. Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly.
 Once the syringe plunger has stopped moving, remove the syringe and discard it in a biohazard waste container.
 Positive Control (Positions 10, 11, 12) - Black Labeled Tube
 1. Fill a new syringe with 0.5 mL of control water from the bottle supplied in the reagent kit.2. Gently insert the cannula tip into the positive inlet port. Push the syringe down until you feel
 an ease in resistance.3. Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly.
 Once the syringe plunger has stopped moving, remove the syringe and discard it in a biohazard waste container.
 4. After all of the four syringes have emptied into the reagent pouch, confirm that each of the dried reagents have dissolved in the liquid.
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 Dissolved Reagent Undissolved Reagent
 If the reagents are dissolving slowly, shake the pouch gently by hand. If they fail to dissolve, consult the “Pouch Troubleshooting” section in the Maintenance and Troubleshooting chapter of the RAZOR EX Operator’s Manual.
 Note: Start run on the instrument by scanning the bar code before beginning pouch preparation.
 Reagent Pouch Loading for 11 + 1 Pouch (The 10®)
 With the unknown samples, use the following steps to insert them into the sample pouch and run a test.
 Follow the prescribed order below to minimize cross-contamination and user error:
 Step 1Unknown Sample 1
 Step 2Water for Positive Controls
 Orange Labeled Tube
 Black Labeled Tube
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 WARNING: DO NOT push the syringe plunger to force liquid into the pouch. This can fill the pouch with air and may damage the pouch or cause contamination.
 Note: Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly. Once the syringe plunger has stopped moving, remove the syringe and discard it in a bio-waste container.
 Unknown Sample - Orange Labeled Tubes(Unknown assays, Positions 1–8; PCR Inhibition Control, Positions 9 and 10) 1. Fill a 3 mL syringe with 2 mL of Unknown Sample 1.2. Gently insert the cannula tip into the Unknown Sample 1 inlet port. Push the syringe down
 until you feel an ease in resistance.3. Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly.
 Once the syringe plunger has stopped moving, remove the syringe and discard it in a biohazard waste container.
 Positive Controls - Black Labeled Tubes (PCR Positive Control, Positions 11 and 12)
 1. Fill a new 1 mL syringe with 0.5 mL of control water from the bottle supplied in the reagent kit.
 2. Gently insert the cannula tip into the positive inlet port. Push the syringe down until you feel an ease in resistance.
 3. Allow the syringe to sit in the inlet port for at least 30 sec. to allow the liquid to dispense evenly. Once the syringe plunger has stopped moving, remove the syringe and discard it in a biohazard waste container.
 4. After both syringes have emptied into the reagent pouch, confirm that each of the dried reagents are dissolved in the liquid.
 Dissolved Reagent Undissolved Reagent
 If the reagents are dissolving slowly, shake the pouch gently by hand. If they fail to dissolve, consult the “Pouch Troubleshooting” section in the Maintenance and Troubleshooting chapter of the RAZOR EX Operator's Manual.
 Note: Start run on the instrument by scanning the bar code before beginning pouch preparation.
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 Scanning the Pouch and Initiating a Run
 Scanning the Pouch Bar Code
 The RAZOR EX instrument displays instructions on the screen to walk the user through the steps of scanning a reagent pouch and performing a run. Each reagent pouch has a unique serial number and rectangular bar code.
 1. Select Run Pouch from the Main Menu to start the loading instructions.
 2. To quit the run after starting, select Back at the bottom of the Scan Barcode screen.3. If the user chooses to continue with the run, the instrument will prompt you to scan the rectan-
 gular pouch bar code from the reagent pouch labeling.
 The bar code reader is located on the back of the instrument next to the power port. Hold the bar code as flat as possible, approximately 6–8 in. from the scanner. If the bar code is not scanned immediately, flatten the bar code or move closer.
 Bar Code Reader
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 Note: If the bar code does not scan properly, the message Aborting Barcode Scan, will dis-play. If you scan the wrong bar code, the message Invalid Barcode Data (Barcode Should Be Rectangular) will appear.You should then scan the rectangular bar code on the pouch’s fitment label. If any bar code becomes smeared or unscannable, generic codes are available on the assay card and in Appendix E.
 4. The screen will display Loading Barcode Data.
 Note: If the appropriate protocol is not present on the instrument, the machine will prompt the user to scan the square protocol bar code from the reagent kit box.
 5. After the bar code is successfully scanned, the instrument begins preheating. The preheat-ing time depicted on the screen depends on the current temperature of the instrument. An instrument at room temperature (18–30°C) requires approximately 8 min. to preheat. When it is complete, a message will appear that says Preheat Complete. Press Select to con-tinue.
 6. The message Remove Old Pouch will appear. Remove the pouch from the previous run and discard it as biohazardous waste.
 Note: Do not tear the pouch when you remove it during the next step; the contents could con-taminate the instrument and surrounding area.
 BIOHAZARD HAZARDOUS MATERIAL: Use standard laboratory procedures when handling biohazardous material. Consider all samples biohazardous and carefully dispose of pouches and syringes in a bio-hazard waste container.
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 7. Press Select to continue.An Inject All Ports screen displays. Load syringe and inject ports as described in “Sample Handling and Preparation.”
 8. When the ports are injected, press Select. If no reverse transcription is indicated, a Preheating screen displays with information about the case temperature. To stop the run, push Select to quit.
 Once preheating is complete, a Preheat Complete window displays. Press Select to con-tinue.
 Note: Protocols that include an reverse transcription step may not require preheating. The instrument will then proceed to the Remove Comb screen.
 Comb Removal, Twisting, and Plunging
 WARNING: Depressing the pouch plungers when the pouch is not in the pouch bracket may damage the pouch, prevent the sample from entering the sample slot, or cause backflow leading to contamination. If at any time during the preparation process you suspect that the exterior of the pouch became contaminated with any suspected biohazardous materials, be sure to wipe off the pouch with 10% bleach (one part chlorine bleach and nine parts water) before inserting it into the RAZOR EX. This will help prevent contamination of the instrument’s internal components which may result in erroneous test results.
 BIOHAZARD HAZARDOUS MATERIAL: Use standard laboratory procedures when handling biohazardous material. Consider all samples biohazardous and carefully dispose of pouches and syringes in a biohazard waste container.
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 Note: Be sure that the outside of the pouch is visually clean before it is inserted into the instrument. If the pouch is unclean, gently wipe it with a dry, lint-free cloth.
 Note: When handling and loading samples, use standard laboratory techniques and follow appropriate protocols for loading samples to avoid contamination problems. Change gloves fre-quently to avoid cross-contamination of samples.
 Note: DO NOT push pouch plungers down until step 5.
 A window displays instructing the user to remove the comb.
 1. Remove the pouch plunger comb(s) by pulling it away from the pouch.
 2. Select To Continue on the Remove Comb screen. The Twist Plungers screen displays.
 Twist plunger by using the plunger twist tool or the end of the plunger comb and rotate each of the plungers 90º towards the center of pouch; this prevents leaking and cross-contamination of neighboring wells. You can also rotate the plungers by hand or with a small flat-head screw-driver.
 3. With the pouch plungers up, lightly tap the pouch on a flat surface.
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 4. Select To Continue on the Twist Plungers screen, a Use Tool to Plunge screen displays.
 Place pouch onto the plunge bracket located near the pouch slot on the RAZOR EX instru-ment.
 5. Holding the reagent pouch in the bracket, slowly push pouch plungers down to force the liquid into the individual sample slots. When all of the plungers have pushed liquid into the sample pouch, the samples are ready to be run.
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 CHAPTER 4: RUNNING THE INSTRUMENT
 1. Select To Continue on the Use Tool to Plunge screen.
 The Analysis Initiation screen displays.
 2. Select Proceed.
 An Insert Pouch screen displays.
 3. Insert the pouch into the instrument with the loading label facing up and the plungers toward the front of the instrument. The pouch fitment should sit perfectly in the groove over the insert slot. After inserting the pouch, select To Continue.
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 The PCR Runtime Menu screen displays.
 The RAZOR EX will begin PCR unless you choose to quit.
 Monitoring PCR Progress
 The user can leave the screen at the current display during PCR, or select the progress screens listed on the PCR Runtime Menu above to view the progress of the run.
 To view the progress of the run on a graph, select View Realtime Graph (example below). This graph displays the curves of each sample. The up and down arrows on the RAZOR EX control panel can be used to highlight specific samples. Slot numbers are displayed at the top of the screen. Also displayed are positive (+) and negative (-) detector calls. A positive (+) call indicates presence of the specific reagent target. A question mark (?) will be indicated until such time as a positive (+)
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 call is determined or the run is completed. At this point, the negative (-) call will be displayed if no amplification is detected.
 View Slot Labels displays the name and slot position of the pouch reagents. This information is uploaded in the square protocol bar code.
 View Progress displays a screen that lists the pouch serial number protocol, time to completion, cycle status, and estimated power. The power source used (External or Battery) will be bright and the one not used will be dimmed.
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 View Status displays a screen that displays the current heating and cooling temperatures of the run and instrument air pressure. The A and B heaters are the denaturing heaters; C and D are the annealing heaters.
 Note: Toggle between each screen by pressing Select.
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 Reviewing and Interpreting Results
 When a run is finished, the screen will automatically display the results (Metacalls) for the run. These results rely on the Detector software algorithm to determine the presence or absence of the target being tested.
 Note: To see all of the Metacalls, scroll down until ‘End of List’ displays.
 Detector
 Detector is an advanced mathematical algorithm that determines if each slot in the pouch has detectable amplification (that is, whether copies were made of the target DNA). Slots are called independently of each other. Detector runs in real time on the instrument: strongly positive slots are called while the machine runs, and the Detector calls at the top of the screen are updated. Negatives are not called until the run is over.
 Calls Meaning of each call
 + The software has detected an amplification curve for a slot position.
 – The software has not detected an amplification curve for a slot position
 ? The software has not determined the correct call yet.
 Metacalls
 The Metacalls program takes the Detector calls for individual slots and gives you combined information about unknowns and assay controls (see “Qualitative Detection Analysis” in chapter 3 of the RAZOR EX Operator’s Manual). Protocols contain all the necessary information for results summaries and details. This information is specific to the reagents present in the pouch and their configuration.
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 Run Screen
 The Review Results screen displays the pouch number, the name of the protocol, and the date and time of the run. It also offers the following options for reviewing the results:
 • Results (Summary): displays combined calls (Metacalls) for unknowns and controls. This screen comes up immediately after a run.
 • Results (Details): specific results for any control failures.
 • View Graph: A graph of the test results
 To display the Review Results screen, select Back from the Results (Summary) screen.
 Results (Summary)
 The following screen is an example of what you will see when you look at a summary of results. The top green section of the screen contains the screen title in the first line and a slot map in the second line. The slot map starts with ‘1’ (slot 1) on the left side of the line and ends with ‘12’ (slot 12) on the right side of the line. Between 1 and 12 there are four groups of three characters each. Each char-acter represents one of the slots from 1 to 12. In this particular screen, you can see a plus symbol and a minus symbol, which are Detector call symbols. Plus symbols show that amplification was detected in the slot.
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 The 11+1 (The 10®) screen above shows a positive test result for the first unknown sample (Anthrax) and positive results for the PCR Inhibition and Positive Control slots. The first line identifies the assay.
 Review Results (Details)
 Results (Details) shows the summary call along with the call for each slot. However, if there are no metacalls, the Results (Details) screen will display “No Metacalls Found.” Also, if a control fails, the test has failed, and the software will not display the metacalls.
 The Detector calls for each slot are shown in green at the top of the screen. Again, the first slot number (1) is listed on the left, the last slot number (12) is listed on the right, and twelve symbols representing the detector calls for the 12 slot numbers are sandwiched in between. The screen contains the masks for each pouch slot. The Detector masks the test results using a mask that was designated in the protocol, then displays the appropriate message.
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 For the masks, the possible results are shown in the following table.
 Calls Meaning of each call
 * Call is not relevant
 – Call is negative
 + Call is positive
 The Detector call for the same slot can generate multiple messages.
 In the mask for Anthrax Detected for Unknown 1:
 • The mask has the number 1 on the left and the number 12 on the right. In between are twelve characters, arranged in four three-character groups.
 • The first group of symbols, + * *, represent slots 1 through 3. In this pouch, these slots con-tain the sample slots for anthrax, Brucella, and botulism A. To generate the result text for this particular example and to match the mask, slot 1 must be positive since it is the sample slot for the anthrax assay.
 • The second group of three symbols, * * *, masks the test results for Coxiella, E. coli, and tula-remia. Since the detector call is not relevant to the detection of anthrax, the mask shows only asterisks in these slots.
 • The third group of symbols, * * *, masks the test results for ricin, Salmonella, and smallpox. This group also had no relevant calls and shows only asterisks.
 • The fourth group of symbols, *++, represent slots 10 through 12. Slot 10 represents plague and displays an * as there were no relevant calls. Slot 11 is for the inhibition control and slot 12 is for the positive control. These both display a positive call indicating that there are no inhibitors and the positive control amplified properly. To generate the result text for this particular example and to match the mask, slot 11 must be positive to show that there is no inhibition and slot 12 must be positive, since it is the positive control for the anthrax assay.
 The following examples shows the results of four test runs. The table identifies the wells, assays, and reagent types. The text following the table shows the test results for this table. The Detector calls are listed first, followed by the summary of results and the details.
 [Kevin: The next section was completely revised in the operator’s manual. Do you want me to repeat all of the examples in this book or just some?]
 Examples of 4 x 3 Test Run Results
 The following examples shows the results of two test runs. The reagents are in a 4 x 3 pouch. The table identifies the wells, assays, and reagent types. The text following the table shows the test results for this table. The detector calls are listed first, followed by the summary of results and the details.
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 Example 1In this specific example, a Biothreat 1 pouch was used to test two unknowns.Anthrax (ANT) was detected in Unknown 1, and no assays were detected in Unknown 2.
 Identification 1st Set of Wells 2nd Set of Wells 3rd Set of Wells 4th Set of Wells
 Well 1 2 3 4 5 6 7 8 9 10 11 12
 Assay Anthrax Ricin F. tul Anthrax Ricin F. tul Anthrax Ricin F. tul Anthrax Ricin F. tul
 Reagent Type Negative Control Unknown 1 Unknown 2 Positive Control
 Detector Calls are --- +-- --- +++
 Results (Summary)Anthrax Detected Unknown 1Ricin Not Detected Unknown 1F. tul Not Detected Unknown 1Anthrax Not Detected Unknown 2Ricin Not Detected Unknown 2F. tul Not Detected Unknown 2
 Example 2In this specific example, one unknown straight and with a dilution was tested for three assays (A, B and C). In this run, the Positive Controls failed; wells 10, 11 and 12 were all negative but should have amplified and been called positive.
 Identification 1st Set of Wells 2nd Set of Wells 3rd Set of Wells 4th Set of Wells
 Well 1 2 3 4 5 6 7 8 9 10 11 12
 Assay A B C A B C A B C A B C
 Reagent Type Negative Control Unknown 1 Unknown 1 Dilution Positive Control
 Detector Calls are --- --- --- --- Results (Summary)Positive Control Failure
 Results (Details) Positive Control Failure\ Assay A1 *** *** *** -** 12 Positive Control Failure\ Assay B
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 1 *** *** *** *-* 12 Positive Control Failure\ Assay C1 *** *** *** **- 12
 Example of 11 + 1 Test Run Results (The 10™)
 The following example shows the results of a test run, where the reagents are in a 11 + 1 pouch. The table identifies the wells, assays, and reagent types. The text following the table shows the test results for this table. The detector calls are listed first, followed by the summary of results and the details, if applicable.
 Example 1In this specific example, an 10-target screen kit was used to test one unknown. The results show the following: 1) the PCR Positive Control worked; 2) the PCR Inhibition Control worked, 3) Assay 4 was detected in Unknown 1, and 4) no other assays were detected.
 Identification 1st Set of Wells2nd
 Set ofWells
 Well 1 2 3 4 5 6 7 8 9 10 11 12
 Assay Antx Bru Bot A Cox E coli Tul Ricin Salm Smpx Plag PCR PCR
 Reagent Type Unknown 1 Inhibition Control
 Positive Control
 Detector Calls are --- +-- --- -++Results (Summary)Coxiella Detected Unknown 1Anthrax Not Detected Unknown 1Brucella Not Detected Unknown 1Botulism A Not Detected Unknown 1E. Coli Not Detected Unknown 1Tularemia Not Detected Unknown 1Ricin Not Detected Unknown 1Salmonella Not Detected Unknown 1Smallpox Not Detected Unknown 1Plague Not Detected Unknown 1
 Example of a 10 + 2 Test Run Results (The 8™)In this specific example, an 8-target screen kit was used to test one unknown. The results show the following:
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 • Positive controls for RT and PCR worked • Inhibition controls for RT and PCR both failed • No assay results are valid since the sample contained inhibitors possibly preventing amplification
 Identification 1st Set of Wells 2nd Set ofWells
 Well 1 2 3 4 5 6 7 8 9 10 11 12
 Assay A B C D E F G H RT PCR RT PCR
 Reagent Type Unknown 1 Inhibition Controls
 Positive Controls
 Detector Calls are --- --- --- -++ Results (Summary)Inhibited Dil & Rerun
 Results (Details) Control Failure\ PCR IC1 *** *** **- *** 12 Control Failure\ RT IC1 *** *** *** -** 12
 Instrument Utility Menus
 The instrument’s Utility menu allows users to select a PC connection (via USB or Bluetooth®), delete files, scan protocol codes, view logs, set the date and time, and view the software version. To access the Utility menu, go to the Main Menu and select Utilities.
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 The following screen will display:
 Note: At the bottom of this screen is a battery level indicator. If the display shows only two white bars or less, you will need to recharge the battery before performing the run.
 Select PC Connection
 The PC Connection option gives users the option of connecting to a PC via the provided USB cable or Bluetooth® with user-provided module and software. From the Select Utility menu select PC Connection.
 Then choose whether to connect via USB or Bluetooth.
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 USB
 1. Plug the USB cable into the RAZOR EX and the computer you want to use.
 2. Select Connect to PC Via USB.
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 Bluetooth
 1. Select Connect to PC Via Bluetooth.
 2. When Bluetooth is enabled, a yellow wireless icon will flash in the top left-hand corner of each screen.
 Yellow icon
 Note: Bluetooth models vary; check the device manual for specific instructions. 3. To connect from the PC, open the Bluetooth program. 4. Search for wireless devices. When the RAZOR EX is detected, connect to it as a serial device.
 The instrument name will appear after it is connected to the instrument.
 This can be repeated for multiple RAZOR EX instruments.
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 Note: Users can only connect to one instrument at a time in real time. To view a different instru-ment, you must disconnect and connect to another RAZOR EX.
 Delete File
 Permits deletion of test results files or protocol files (single files or all at once). Selection of specific single files can be aided by choosing the preferred method of sorting files (Date, Protocol, or Pouch Number).
 Note: The RAZOR EX can store up to 75 tests before deletions are required.
 Scan Protocol Code
 Initializes the bar code scanner and permits pre-loading of pouch protocols.
 View Logs
 Permits viewing or deletion of Error Logs and Status Logs. Error Logs include date, time and error codes for all fault messages. Status Logs include date and time for RAZOR EX power on, start and end for each PCR test, and RAZOR EX shutdown.
 Set Date and Time
 Permits setting current date and time. Plus (+) or minus (-) for day, month, year, hour, minute, or second.
 View Software Version
 Permits viewing the version information for the major RAZOR EX software components.
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 The RAZOR EX software allows you to perform and analyze test runs. The data (including run anal-ysis and user accounts) is stored separately in a database called Exor.
 Installing RAZOR Software and Exor Database
 Note: See “Installing the RAZOR EX Software” in Chapter 3 of the RAZOR EX Operator’s Manual for install screens.1. Load the RAZOR EX software using the CD provided with the instrument. A file menu will display.2. Select RazorSetup.exe from the file menu. A Welcome screen will display. Select Next.3. The InstallShield Wizard will display. Select Next to start the Wizard. 4. When the InstallShield Wizard has completed installing, click Next. The End User License
 Agreement will display. Read through the agreement. If you agree with the terms, select Yes.5. A message will display asking you where you want the RazorSW software to be located. Either
 use the browse window to select a location or use the displayed default location by selecting Next.
 6. The wizard will then allow you to choose which icons are added for the software.7. If the Exor database has not been installed on your computer, the Exor InstallShield Wizard will
 begin installing.8. After Exor has been installed, the software install will then launch the install for the correct USB
 drivers.
 Installing RAZOR USB Drivers for USB Cable
 1. The RAZORSW.exe will initiate the installation of the USB drivers.
 2. Follow prompts of install shield wizard.
 3. After install completes, restart computer.
 Connect RAZOR to computer using USB cable.
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 Starting the RAZOR EX Software
 The RAZOR EX software allows you to perform and analyze test runs. The data (including runs and user accounts) is stored separately in a database called Exor.
 1. Load RAZOR EX software using CD and install instructions provided with instrument.2. Start the RAZOR EX instrument, then start the computer connected to the instrument according
 to the setup instructions in Chapter 2 of the operator’s manual, Installation and Setup.3. Verify that the double-arrow database icon appears in the system tray, which is in the lower right
 corner of your desktop.
 The icon indicates that the database management software (called Exor) has started. You can also start the database by opening the Start menu, then selecting Programs\IdahoTech\Exor3.
 4. Start the RAZOR EX software by double-clicking the RAZOR EX icon on your desktop. You can also start the software by opening the Start menu, then selecting Programs\IdahoTech\RazorSW.
 A login dialogue box opens.
 5. Enter your user name and password, leave Traceable in the Log on to: box and then click Login.
 The default user name is admin and the password is master.
 Note: You will need to change your password the first time you log in.
 The front screen for the RAZOR EX software opens.
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 The front screen displays two buttons:• Connect to RAZOR EX: This button allows users to move files from the RAZOR EX to a
 computer. This requires a connection between the instrument and computer (that is, USB or Bluetooth).
 • Analysis: This button allows users to view files that have already been stored in the soft-ware database.
 6. Click one of the buttons, or, to work with items already in the database, select View > Navigator. Navigator displays the contents of the database in a tree list to the left of the front screen.
 Connecting to the RAZOR EX Software
 To view RAZOR EX files you must first connect to the RAZOR EX instrument to download test runs, save them to the computer’s hard drive, and then import them into the software.
 1. Connect to the instrument by selecting Main Menu > Utilities > Select PC Connection. Choose USB or Bluetooth, and then either connect the USB cable or find the device with your Bluetooth software.
 2. Click Connect To Razor on the front screen
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 3. The software opens a dialogue box, Searching for Razor Instruments, and a progress bar. If any RAZOR EX instruments are connected to the computer and powered on, the software will detect them. If the software does not find any RAZOR EX instruments, it displays a message.
 4. If the software detects RAZOR EX instruments, the Searching dialogue box will disappear. Select the correct I/O port from the I/O port drop down menu.
 5. The serial number of the instrument appears in the Instrument Name box after you select the correct I/O port
 Note: You MUST select the I/O port for the instrument name to appear.
 6. You may select one of the following choices.
 This button copies files from the instrument.
 This button copies files and then deletes them from the RAZOR EX.
 7. A browse window opens, allowing you to select the location where you want to save the files. The preferred location for RAZOR EX files is c:\Program Files\IdahoTech\RazorSW\Data.
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 8. A dialogue box appears with a progress bar as the software copies the files. After all the files are copied, the dialogue box disappears. You may then connect to another RAZOR EX and repeat the process, or close the window and begin importing the files.
 Importing Files
 Importing Selected Files
 You can import one or more selected files by using the File > Import command.
 To use the Import command to import files1. From the RAZOR EX software, select File > Import, then select the correct type of file, as follows:
 • For RAZOR EX Software files, select RZ4 Files.
 • For RAZOR III Software files, select Object .ixo Files.
 2. Select the files you want to import.RAZOR EX files are stored on the local hard drive at c:\Program Files\IdahoTech\RazorSW\Data (or a different location if the person who downloaded the data selected something other than the preferred location). The run name includes the instrument serial number, protocol, and pouch serial number, which makes it easy to locate files.
 To select multiple files, press Ctrl while selecting the file names, or press Shift to select con-secutive files.
 3. Click Open.
 Note: These files have been imported into the software, but have not been saved in the RAZOR EX database.
 4. To save the currently displayed file in the RAZOR EX Software database, click Save, select the folder to store the file in (default is Analytical Runs), then click Save. You cannot save a file to a folder where it already exists unless you either rename it or replace the original file.
 5. To save each of the remaining imported files (if any), click the file name in the task bar to make the file active in the work pane; click Save, select a folder, then click Save.
 Importing a Directory of Files
 1. From the RAZOR EX software, select File > Batch Import.
 The Batch Import dialogue box displays.
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 2. Click Add.3. Find and select the directory you want to import, then click OK.
 • The directory path is added to the window.
 • The default location for RAZOR EX files is c:\Program Files\IdahoTech\RAZORSW\Data (or a different location if the person who downloaded the data selected something other than the preferred location).
 4. Check Include subdirectories if you want to include the subdirectories of the directory.5. Repeat Steps 2–4 to add additional directories as needed.6. To remove any of the paths you have added:
 • Click in the Remove column for the file. The software displays a gray button.
 • Click the button to remove the file.
 7. Repeat the process in order to add more directories.8. When you are finished adding directories, click Next.9. Select the folder in the database where you want to store the imported files, then click Next.10. Select the type of file to import. RAZOREX files are .RZ4 files, and RAZOR III files are .ixo
 object files.11. Select the action for duplicate files.12. The next tab displays the current status of the imported files. Any failed imports will have infor-
 mation reported in the Messages column. Maximizing the window and resizing the columns will allow you to read long messages. You cannot save a file to a folder where it already exists unless you either rename it or replace the original file. When all the files have been imported, view the results on the Import Done tab.
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 13. To redo the import with different import parameters:• Click Previous twice in order to return to the Start Import tab.
 • Click Reset.
 • Change the parameters you want, then click Next to re-import the files.
 14. When you are finished, close the dialogue box by clicking Done on the Import done tab.
 Exporting Files
 Exporting an Individual Item
 1. In RAZOR EX software, open the run to be exported. The item must be open in the work pane before it can be exported.
 2. Select File > Export.3. Navigate to a location to save the exported file, make sure that XML Object Files (.ixo) is
 selected as the file type, enter a new file name (or keep the existing name), and then click Save. The file is saved with an .ixo extension.
 Exporting a Test’s Raw Data
 1. In RAZOR EX software, open the test containing the data you want to export.The item must be open in the work pane before you can export it.
 2. Select File > Export.3. Navigate to a location to save the exported data, select Raw data file (.txt) as the file type,
 enter a new file name (or keep the existing name), and then click Save.The text file contains the raw fluorescence and temperature values for each data acquisition point in the test. You can use any text editor, such as Notepad, to open the file.
 Exporting a Folder of Items
 1. Select File > Batch export. The Batch export dialogue box is displayed.

Page 68
                        

NOTES: ____________________________________________________________________
 _____________________________________________________________________________
 _____________________________________________________________________________
 _____________________________________________________________________________
 _____________________________________________________________________________
 RAZOR EX Basic Training Workbook < > Idaho Technology Inc.< 68 >
 Chapter 5: Software
 2. In the folder tree, highlight the folder containing the items to export. 3. Leave Scan Sub-folders selected if you want to include subfolders in the export. 4. Click Next.5. Click Browse to display a file selection dialogue box.6. Find and select the location in which to store the exported files, then click OK.7. Click Next.
 A tab with export options is displayed.
 8. Select the object types to export. 9. Select the date range for the objects by creation date or modification date.
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 10. Select the operation to perform if a file should already exist with the same name as a file being exported.
 11. Select whether to delete objects from the database after they are exported. This operation cannot be undone after the export is complete. However, you can reimport objects again if you need to restore them to the database.
 12. Click Next.The tab displays a summary of the export paths (from and to).
 13. If the paths are correct, click Next to begin the export. (Otherwise, click Previous to return to previous tabs and make corrections.)The export begins. The tab displays the current status of the export operation for each file. Maximizing the window and resizing the columns allows you to read long messages. When all the files have been exported, the Export done tab is automatically displayed.
 14. View results on the Export Done tab, then click Done to close the dialogue box.
 Qualitative Detection Analysis
 The Qualitative Detection analysis module analyzes unknown samples for the presence of a nucleic acid target based on the presence or absence of a crossing point (Cp) in each sample’s data. The RAZOR EX Software uses the Qualitative Detection analysis to generate results.
 Note: Temperature graphs are not imported for RAZOR EX files; only the temperature at the fluorescence acquisition is displayed.
 Understanding the Results
 Results for each slot include a section labeled Calls and a section labeled Results. The Target col-umn displays the amplification result for the slot position based only on the slots amplification profile.
 Value Explanation of the Target ColumnPositive Amplification was detected in the slot.
 Negative Amplification was not detected in the slot.
 Target Call A positive or negative call for the slot based on amplification curve. Calls are made by Detector (which is part of the RAZOR EX instrument).
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 Results columns show the following:
 Contents CommentsCp The sample crossing point, in cycles.Max Fluor (Background)
 The level of fluorescence increase, determined by subtracting baseline fluo-rescence level from highest level of fluorescence reached by the sample.
 You can highlight individual samples by selecting them with the mouse. You can view multiple sam-ples by holding down the Ctrl key while selecting samples you want to examine or the Shift key for consecutive samples.
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 CHAPTER 6: MAINTENANCE
 For a complete guide to troubleshooting error codes and pouch problems and performing main-tenance procedures, please see Chapter 4, Maintenance and Troubleshooting, in the RAZOR EX Operator’s Manual.
 • As needed, wipe down the surface of the RAZOR EX with 10% bleach (one part chlorine bleach and nine parts water) using a cloth or paper towel, followed by wiping it down with distilled water to remove any bleach contaminants. This process should be repeated three times. Be sure not to mix the bleach solution with other chemicals (mixture with acid will liberate chlorine gas). Use this method to decontaminate the RAZOR EX before returning it for service.
 • Periodically, clean the sample chamber area between the internal heater plates by blowing it out using canned air. Be sure to wear eye protection.
 • Periodically, clean the optic lens and heater plates using optical lens cleaner and lens cloth.• Always wear gloves when accessing and maintaining internal parts.
 Note: If the instrument has been used to test or has detected live agent, fumigation (i.e., ethyl-ene oxide) is required. Contact ITI Technical Support for instructions.
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 APPENDIX A: FIRST AID
 Accidental Exposure Procedures
 • Notify the lab supervisor and the site safety officer immediately. If they are not available, go directly to an Emergency Room.
 • The lab supervisor and site safety officer must assess the situation, alert other employees to potential contamination, and control access to the area.
 • The exposed employee is required to have a medical evaluation and follow-up immediately after an exposure incident.
 • The site safety officer must complete an incident report and document the route of exposure, name of the potentially infectious material, and root cause of any accidental exposure.
 Eye Contact
 Check for and remove any contact lenses and immediately flush eyes with copious amounts of water for at least 15 min. Ensure adequate flushing of the eyes by separating the eye lids with the fingers. Seek medical attention.
 Skin Contact
 Immediately wash skin with soap and copious amounts of water for at least 15 min. Remove con-taminated clothing and shoes. Seek medical attention.
 Inhalation
 Remove to fresh air. If not breathing, give artificial respiration. If breathing is difficult, give oxygen. Seek medical attention.
 Ingestion
 Immediately seek medical attention.
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 APPENDIX B: VOLUME SHEETA metric prefix is a modifier on the root word that tells us the unit of measure. For example, centi-gram one one-hundredth of a gram, mg means thousandths of a gram, etc.
 A List of the Metric Prefixes
 Multiplier Prefix Symbol Numerical Exponential giga G 1,000,000,000 10 9 mega M 1,000,000 10 6 kilo k 1,000 10 3 hecto h 100 10 2 deca da 10 10 1 no prefix means: 1 10 0 deci d 0.1 10 -1 centi c 0.01 10 -2 milli m 0.001 10 -3 micro µ 0.000001 10 -6 nano n 0.000000001 10 -9 pico p 0.000000000001 10 -12 femto f 0.000000000000001 10 -15

Page 76
                        

NOTES: ____________________________________________________________________
 _____________________________________________________________________________
 _____________________________________________________________________________
 _____________________________________________________________________________
 _____________________________________________________________________________
 RAZOR EX Basic Training Workbook < > Idaho Technology Inc.< 76 >
 Appendix B: Volume Sheet
 Volumes used in PCRmicroliter = µL
 = 10-6 Lmilliliter = mL
 = 10-3 L
 Weights used in PCRnanograms = ng
 = 10-9 gpicograms = pg
 = 10-12 gfemptograms = fg
 = 10-15 g
 How to..How do you mix a 1:10 or 10% solution? Use the following table as a guide.
 Bottle Size
 1 Cup (in oz.)
 1 Cup (in mL)
 1 L(in oz.)
 1 L (in mL)
 1 qt. (in oz.)
 1 qt. (in mL)
 1 gal. (in oz.)
 1 gal. (in mL)
 Water 7.2 oz. 212.9 mL 30.3 oz. 900 mL 28.8 oz. 851.4 mL 115.2 oz 3406.5 mL
 Bleach 0.8 oz. 23.6 mL 3.3 oz. 100 mL 3.2 oz. 94.6 mL 12.8 oz 378.5 mL
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 APPENDIX D: RETURN MATERIAL
 AUTHORIZATION
 To return an instrument for replacement or repair, follow the steps below. Complete return instructions and return forms can be found in the RAZOR EX Operator’s Manual, Appendix B, Decontamination and Return Forms or on http://www.idahotech.com/Support/ReturnForms.html. If you have questions, please call 1-800-735-6544 or (801) 736-6354.
 1. Obtain a Return Materials Authorization Number: Fill out a Return Materials Authorization Fax form and fax it to Idaho Technology at (801) 588-0507. A customer service representative will contact you with a number and instructions.
 2. Decontaminate all returned equipment: Thoroughly decontaminate the unit by wiping it down with a 10% bleach solution (chlorine bleach diluted 1 part bleach to 9 parts water), followed by wiping it down with distilled water to remove any bleach contaminants. Repeat twice for a total of three wipes.
 If corrosion from the bleach is a problem, you may flush the instrument with water AFTER the bleach solution has been in contact for at least 10 min. If the instrument has been used to test or has detected live agent, fumigation (i.e., ethylene oxide) is required. Contact ITI technical support for instructions.
 3. Decontamination Labels: Complete and sign. Make a copy for your records. Attach one origi-nal to the instrument and one original to the outside of the shipping container.
 4. Packaging and Shipping: Wrap the RAZOR EX case in a plastic bag before inserting it into the box. Place at least 2" of foam or packaging material on the bottom of a heavy weight box (rec-ommended box size 24" x 20" x 12".) Place the wrapped RAZOR EX back side down with the start-up kit directly next to the machine. Place two or more inches of foam or packaging material all around the instrument. You may place a copy of the Return Materials Authorization Fax with the instrument.
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 This form may be faxed to our return center at 1-801-588-0507 (U.S. and Canada) or +1-801-588-0507 (International). It must also be included with the returned instrument.
 If your equipment is still under warranty, please supply the purchase date and instrument serial number. If your instrument is out of warranty, please supply a blank PO# for the repair and shipping charges. Please note that your item must be returned with a ITI assigned RMA# and decontamina-tion documentation.
 From: _________________________________ Pages: ___________________________
 Attn.: _____________________________
 Ship to: Idaho Technology Inc. Warranty: __________________________ 390 Wakara Way Salt Lake City, UT 84108 Nonwarranty: _______________________ USA
 Date: ________________________________
 RMA#: _______________________________ (required when returning an instrument)
 Company: ____________________________
 Department: ___________________________ PO#: ___________________________________
 Phone: _______________________________ Fax: ____________________________________
 Model: _______________________________ Serial No. _______________________________
 Laptop Login and Password (needed to QC test the RAZOR EX system): ____________________
 _______________________________________________________________________________
 Notes: __________________________________________________________________________
 _______________________________________________________________________________
 _______________________________________________________________________________
 The decontamination form and labels must be completed before the instrument is returned to Idaho Technology. If the unit is returned without decontamination documentation, it will be shipped back to you at your expense. Nonwarranty charges are standard labor charges with a 2-hour minimum charge plus parts and shipping charges. If the unit cannot be repaired, it will either be returned to you or disposed of upon your request. Thank you for your business and for supporting the health and well being of our employees.
 Signature: _______________________________ Date: ___________________________________
 RetuRn MateRials authoRization Fax pg. 1 oF 2
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 Declaration of Decontamination
 This instrument has been decontaminated according to established Idaho Technology Inc. biologi-cal decontamination procedures.
 Which method was used? _________________________________________________________
 ______________________________________________________________________________
 ______________________________________________________________________________
 What chemical, infectious, toxic or radioactive substances have been in contact with this product? (Also indicate if flammable or corrosive.) ______________________________________________
 ______________________________________________________________________________
 ______________________________________________________________________________
 Authorization Notice
 By accepting this authorization to return this product, the user assumes all responsibility for decon-tamination and cleaning. Idaho Technology Inc. reserves the right to refuse the delivery of prod-ucts, which do not appear to have been properly decontaminated. If the equipment was used with or around radioactive material, the signature of the safety officer is also required.
 Signature: _______________________________ Date: __________________________________
 RetuRn MateRials authoRization Fax pg. 2 oF 2
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 Decontamination Labels
 Please complete these decontamination labels and affix one to the instrument case and the other to the exterior of the shipping carton. Failure to decontaminate before shipping to Idaho Technology Inc. will result in the immediate return of the unit at your expense.
 Copy and cut out the label and attach it to the case of the instrument being returned.
 DECONTAMINATION NOTICE:This product has been decontaminated per Return Equipment policy: _______
 Idaho Technology Return Authorization (RMA#): _________________________
 Customer Name: _________________________________________________
 Customer Address: ________________________________________________
 _______________________________________________________________
 Signature: ____________________________________ Date: ____/___/____
 Copy and cut out the label and attach it to shipping container of the instrument being returned.
 DECONTAMINATION NOTICE:This product has been decontaminated per Return Equipment policy: _______
 Idaho Technology Return Authorization (RMA#): _________________________
 Customer Name: _________________________________________________
 Customer Address: ________________________________________________
 _______________________________________________________________
 Signature: ____________________________________ Date: ____/___/____
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 APPENDIX E: BAR CODES
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITYEASTB
 PA
 TH
 -PR
 T-0
 288 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0006
 ITYEASTB-YETB0001 ITYEASTB-YETB0002 ITYEASTB-YETB0003
 ITYEASTB-YETB0004 ITYEASTB-YETB0005 ITYEASTB-YETB0006
 ITYEASTB-YETB0007 ITYEASTB-YETB0008 ITYEASTB-YETB0009
 ITYEASTB-YETB0010 ITYEASTB-YETB0011 ITYEASTB-YETB0012
 ITYEASTB-YETB0013 ITYEASTB-YETB0014 ITYEASTB-YETB0015
 ITYEASTB-YETB0016 ITYEASTB-YETB0017 ITYEASTB-YETB0018
 ITYEASTB-YETB0019 ITYEASTB-YETB0020 ITYEASTB-YETB0021
 ITYEASTB-YETB0022 ITYEASTB-YETB0023 ITYEASTB-YETB0024
 ITYEASTB-YETB0025 ITYEASTB-YETB0026 ITYEASTB-YETB0027
 ITYEASTB-YETB0028 ITYEASTB-YETB0029 ITYEASTB-YETB0030
 RAZOR Yeast Pouch
 ITFCTRNA-00000001 ITFCTRNA-00000002 ITFCTRNA-00000003
 ITFCTRNA-00000004 ITFCTRNA-00000005 ITFCTRNA-00000006
 ITFCTRNA-00000007 ITFCTRNA-00000008 ITFCTRNA-00000009
 ITFCTRNA-00000010 ITFCTRNA-00000011 ITFCTRNA-00000012
 ITFCTRNA-00000013 ITFCTRNA-00000014 ITFCTRNA-00000015
 ITFCTRNA-00000016 ITFCTRNA-00000017 ITFCTRNA-00000018
 ITFCTRNA-00000019 ITFCTRNA-00000020 ITFCTRNA-00000021
 ITFCTRNA-00000022 ITFCTRNA-00000023 ITFCTRNA-00000024
 ITFCTRNA-00000025 ITFCTRNA-00000026 ITFCTRNA-00000027
 ITFCTRNA-00000028 ITFCTRNA-00000029 ITFCTRNA-00000030
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: ITFCTRNA
 'PA
 TH
 -PR
 T-0
 305 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0005
 RAZOR Training Pouch (Color Dyes)
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: SIMUL10A
 PA
 TH
 -PR
 T-0
 368 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0091
 Simulant Training Pouch
 10TARGTB-10TAR001 10TARGTB-10TAR002 10TARGTB-10TAR003
 10TARGTB-10TAR004 10TARGTB-10TAR005 10TARGTB-10TAR006
 10TARGTB-10TAR007 10TARGTB-10TAR008 10TARGTB-10TAR009
 10TARGTB-10TAR010 10TARGTB-10TAR011 10TARGTB-10TAR012
 10TARGTB-10TAR013 10TARGTB-10TAR014 10TARGTB-10TAR015
 10TARGTB-10TAR016 10TARGTB-10TAR017 10TARGTB-10TAR018
 10TARGTB-10TAR019 10TARGTB-10TAR020 10TARGTB-10TAR021
 10TARGTB-10TAR022 10TARGTB-10TAR023 10TARGTB-10TAR024
 10TARGTB-10TAR025 10TARGTB-10TAR026 10TARGTB-10TAR027
 10TARGTB-10TAR028 10TARGTB-10TAR029 10TARGTB-10TAR030
 RAZOR The 10® Target Screen Kit
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT1B
 PA
 TH
 -PR
 T-0
 290 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0008
 BIOTRT1B-BIO1B001 BIOTRT1B-BIO1B002 BIOTRT1B-BIO1B003
 BIOTRT1B-BIO1B004 BIOTRT1B-BIO1B005 BIOTRT1B-BIO1B006
 BIOTRT1B-BIO1B007 BIOTRT1B-BIO1B008 BIOTRT1B-BIO1B009
 BIOTRT1B-BIO1B010 BIOTRT1B-BIO1B011 BIOTRT1B-BIO1B012
 BIOTRT1B-BIO1B013 BIOTRT1B-BIO1B014 BIOTRT1B-BIO1B015
 BIOTRT1B-BIO1B016 BIOTRT1B-BIO1B017 BIOTRT1B-BIO1B018
 BIOTRT1B-BIO1B019 BIOTRT1B-BIO1B020 BIOTRT1B-BIO1B021
 BIOTRT1B-BIO1B022 BIOTRT1B-BIO1B023 BIOTRT1B-BIO1B024
 BIOTRT1B-BIO1B025 BIOTRT1B-BIO1B026 BIOTRT1B-BIO1B027
 BIOTRT1B-BIO1B028 BIOTRT1B-BIO1B029 BIOTRT1B-BIO1B030
 BioThreat 1 Kit
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BIOTRT2B
 PA
 TH
 -PR
 T-0
 291 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0009
 BIOTRT2B-BIO2B001 BIOTRT2B-BIO2B002 BIOTRT2B-BIO2B003
 BIOTRT2B-BIO2B004 BIOTRT2B-BIO2B005 BIOTRT2B-BIO2B006
 BIOTRT2B-BIO2B007 BIOTRT2B-BIO2B008 BIOTRT2B-BIO2B009
 BIOTRT2B-BIO2B010 BIOTRT2B-BIO2B011 BIOTRT2B-BIO2B012
 BIOTRT2B-BIO2B013 BIOTRT2B-BIO2B014 BIOTRT2B-BIO2B015
 BIOTRT2B-BIO2B016 BIOTRT2B-BIO2B017 BIOTRT2B-BIO2B018
 BIOTRT2B-BIO2B019 BIOTRT2B-BIO2B020 BIOTRT2B-BIO2B021
 BIOTRT2B-BIO2B022 BIOTRT2B-BIO2B023 BIOTRT2B-BIO2B024
 BIOTRT2B-BIO2B025 BIOTRT2B-BIO2B026 BIOTRT2B-BIO2B027
 BIOTRT2B-BIO2B028 BIOTRT2B-BIO2B029 BIOTRT2B-BIO2B030
 BioThreat 2 Kit
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 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: BA3TRGTB
 PA
 TH
 -PR
 T-0
 289 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0007
 BA3TRGTB-BA3TB001 BA3TRGTB-BA3TB002 BA3TRGTB-BA3TB003
 BA3TRGTB-BA3TB004 BA3TRGTB-BA3TB005 BA3TRGTB-BA3TB006
 BA3TRGTB-BA3TB007 BA3TRGTB-BA3TB008 BA3TRGTB-BA3TB009
 BA3TRGTB-BA3TB010 BA3TRGTB-BA3TB011 BA3TRGTB-BA3TB012
 BA3TRGTB-BA3TB013 BA3TRGTB-BA3TB014 BA3TRGTB-BA3TB015
 BA3TRGTB-BA3TB016 BA3TRGTB-BA3TB017 BA3TRGTB-BA3TB018
 BA3TRGTB-BA3TB019 BA3TRGTB-BA3TB020 BA3TRGTB-BA3TB021
 BA3TRGTB-BA3TB022 BA3TRGTB-BA3TB023 BA3TRGTB-BA3TB024
 BA3TRGTB-BA3TB025 BA3TRGTB-BA3TB026 BA3TRGTB-BA3TB027
 BA3TRGTB-BA3TB028 BA3TRGTB-BA3TB029 BA3TRGTB-BA3TB030
 RAZOR BA3 Target Kit
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNBP
 AT
 H-P
 RT
 -0293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: WATRSCNB
 PA
 TH
 -PR
 T-0
 293 R
 ev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0011
 WATRSCNB-WATRB001 WATRSCNB-WATRB002 WATRSCNB-WATRB003
 WATRSCNB-WATRB004 WATRSCNB-WATRB005 WATRSCNB-WATRB006
 WATRSCNB-WATRB007 WATRSCNB-WATRB008 WATRSCNB-WATRB009
 WATRSCNB-WATRB010 WATRSCNB-WATRB011 WATRSCNB-WATRB012
 WATRSCNB-WATRB013 WATRSCNB-WATRB014 WATRSCNB-WATRB015
 WATRSCNB-WATRB016 WATRSCNB-WATRB017 WATRSCNB-WATRB018
 WATRSCNB-WATRB019 WATRSCNB-WATRB020 WATRSCNB-WATRB021
 WATRSCNB-WATRB022 WATRSCNB-WATRB023 WATRSCNB-WATRB024
 WATRSCNB-WATRB025 WATRSCNB-WATRB026 WATRSCNB-WATRB027
 WATRSCNB-WATRB028 WATRSCNB-WATRB029 WATRSCNB-WATRB030
 RAZOR Water Screen 3 Target Kit
 8TGTSCNB-8TGTB001 8TGTSCNB-8TGTB002 8TGTSCNB-8TGTB003
 8TGTSCNB-8TGTB004 8TGTSCNB-8TGTB005 8TGTSCNB-8TGTB006
 8TGTSCNB-8TGTB007 8TGTSCNB-8TGTB008 8TGTSCNB-8TGTB009
 8TGTSCNB-8TGTB010 8TGTSCNB-8TGTB011 8TGTSCNB-8TGTB012
 8TGTSCNB-8TGTB013 8TGTSCNB-8TGTB014 8TGTSCNB-8TGTB015
 8TGTSCNB-8TGTB016 8TGTSCNB-8TGTB017 8TGTSCNB-8TGTB018
 8TGTSCNB-8TGTB019 8TGTSCNB-8TGTB020 8TGTSCNB-8TGTB021
 8TGTSCNB-8TGTB022 8TGTSCNB-8TGTB023 8TGTSCNB-8TGTB024
 8TGTSCNB-8TGTB025 8TGTSCNB-8TGTB026 8TGTSCNB-8TGTB027
 8TGTSCNB-8TGTB028 8TGTSCNB-8TGTB029 8TGTSCNB-8TGTB030
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: 8TGTSCNB
 PA
 RT
 -NU
 M-B
 ER
 A R
 ev #
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0056
 8 Target or CDN Screen Kit
 FOODSCNB-FOODB001 FOODSCNB-FOODB002 FOODSCNB-FOODB003
 FOODSCNB-FOODB004 FOODSCNB-FOODB005 FOODSCNB-FOODB006
 FOODSCNB-FOODB007 FOODSCNB-FOODB008 FOODSCNB-FOODB009
 FOODSCNB-FOODB010 FOODSCNB-FOODB011 FOODSCNB-FOODB012
 FOODSCNB-FOODB013 FOODSCNB-FOODB014 FOODSCNB-FOODB015
 FOODSCNB-FOODB016 FOODSCNB-FOODB017 FOODSCNB-FOODB018
 FOODSCNB-FOODB019 FOODSCNB-FOODB020 FOODSCNB-FOODB021
 FOODSCNB-FOODB022 FOODSCNB-FOODB023 FOODSCNB-FOODB024
 FOODSCNB-FOODB025 FOODSCNB-FOODB026 FOODSCNB-FOODB027
 FOODSCNB-FOODB028 FOODSCNB-FOODB029 FOODSCNB-FOODB030
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: FOODSCNB
 PA
 TH
 -PR
 T-0
 292
 Rev
 01
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0010
 RAZOR Food Screen 3 Target Kit
 GENERICB-GENB0001 GENERICB-GENB0002 GENERICB-GENB0003
 GENERICB-GENB0004 GENERICB-GENB0005 GENERICB-GENB0006
 GENERICB-GENB0007 GENERICB-GENB0008 GENERICB-GENB0009
 GENERICB-GENB0010 GENERICB-GENB0011 GENERICB-GENB0012
 GENERICB-GENB0013 GENERICB-GENB0014 GENERICB-GENB0015
 GENERICB-GENB0016 GENERICB-GENB0017 GENERICB-GENB0018
 GENERICB-GENB0019 GENERICB-GENB0020 GENERICB-GENB0021
 GENERICB-GENB0022 GENERICB-GENB0023 GENERICB-GENB0024
 GENERICB-GENB0025 GENERICB-GENB0026 GENERICB-GENB0027
 GENERICB-GENB0028 GENERICB-GENB0029 GENERICB-GENB0030
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Scan this barcode into your RAZOR EX instrumentbefore running a test.
 Protocol Code: GENERICB
 PA
 TH
 -PR
 T-0
 001 R
 ev 0
 1
 Consult the instrument manual or pouchinstruction booklet for additional information.
 During the scan, the barcode reader will emit abright green aiming beam surrounded by red light.The beam should be centered over the barcode inany direction. Hold the barcode approximately 6–8in. from the back of the instrument.
 Kit Part Number: PATH-ASY-0092
 Generic Barcode
 The GENERICB protocol can be used with both RAZOR-ASY-4000 and RAZR-ASY-4001. However, it requires REV 2 or higher of the RAZOR Master Controller Software. To check your instrument’s version, select Utilities from the RAZOR instrument’s main menu, then select View software vers. and scroll down to the master controller.
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 Agent: specific biological target.
 Assay: Chemicals that test for the presence of a specific target.
 Annealing: The second step in a amplifica-tion cycle where the primers bind the DNA sequence to initiate product extension. This step is optimized according to the melting tem-perature of the primers (60°C for RAZOR).
 Cannula: Plastic syringe tip, replaces a hypoder-mic needle
 Comb: The comb is part of the pouch system first used to hold the plungers in place during ship-ment and preparation and then used as a tool to help rotate the plungers.
 Denaturation: The first step in an amplification cycle where the double-stranded DNA is melted at high temperature (91°C) into single strands.
 Detector: Automatic call software that calls each sample slot in the pouch positive or negative for test agents.
 Download Data: Transfer of experiment data from the RAZOR instrument to a computer.
 Exor3: Database software used by the RAZOR Software for data storage.
 Fluorescence Monitoring: Measurement of light emitted from a fluorescent probe.
 Freeze-Dried Reagent: a combination of chemi-cal and biological compounds specifically tar-geted to a specific agent gene sequence that have been dried to increase shelf life and elimi-nate special storage conditions.
 Inhibition Controls: Reagent that contains all necessary chemicals including target DNA. A sample is added to test for the presence of inhibitors such as bleach or salts.
 LED: Light Emitting Diode, used to generate the light source to excite fluorescence probes in the samples.
 Metacall: Protocol software that determines pres-ence of biological agent by analyzing controls and unknowns.
 mL: A milliliter (1/1,000 of a liter), a unit of mea-surement for liquids.
 Negative Controls: Contain all necessary reagents except DNA.
 Organism: Biologic target usually associated with the disease causing agent, i.e., bacteria or virus.
 Plunger: The part of the pouch system used to push and hold the liquid samples in the bag.
 Positive Controls: Contain all necessary reagents including target DNA.
 Pouch: A thin, clear, flexible plastic fitment attached to a semi-flexible loading body.
 Protocol: Preset temperature cycling parameters, sample information, and Metacall settings for a RAZOR experiment to be run.
 Target: Specific gene sequence in a given organ-ism; many pathogenic agents have several target-specific assays for identification.
 Thermocycling: Repeatedly heating and cooling a liquid sample to perform DNA amplification.
 µL: A microliter (1/1,000,000 of a liter), a unit of measurement for liquids.
 Unknown: Sample of water, air, soil, blood, etc. prepared into a liquid sample to be tested for agent.
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